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I.

dobe Audition é um programa de edição de arquivos áudio, com várias utilidades, pode ser usado 

se

pu

odem ser usados para uma infinidade de fins. 

s

igital e abrir para ti o vasto mundo de edição digital de arquivos áudio. 

I.ÁREA DE TRABALHO 

omponentes básicos 

 Adobe Audition é constituído por vários componentes dos quais: 

 

 
 
 
 
 
 
 

 INTRODUÇÃO 
 

A

em estúdios de música para gravar e misturar instrumentos e vozes ou em rádios para montar 

ssões de programas que vão ao ar, ou para gravar e montar simples e sofisticados spots 

blicitários. Em suma Adobe Audition pode ser usado para gravar e editar sons que em segida 

p

 

E te manual vem servir de ajuda na compreensão deste que é um dos melhores programas de Edição 

D

 

I
 

C
 

O
 
 

 
 

Fig.1 Janela do Adobe Audition 



 
(A) View Options; 

(B) Menu Bar; 

 
 

(C) Toolbars; 
(D) Display windows; 
(E) Various windows; 

 
 
 

(A) View Options 
 

View Options é o conjunto das três mais importantes áreas de trabalho, a saber: Edith
Mulitrack View e CD View cada uma com a sua função especifica. 

 View, 
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 Edit View (visão de edição) — 
É  área de trabalho onde o 

ficheiro áudio é editado. Nesta 
área o Adobe Audition permite 
que se altere o ficheiro áudio 

com bastante precisão. 

 

 

 Multitrack View

 

 

 (visão 
múltipla) — é a área de 

trabalho que possibilita que 
muitos ficheiros áudio sejam 

misturados. 

 
 
 
 
 
 
 
 
 

 
 

 CD View  (Visao de CD) – é a área 
de trabalho onde os ficheiros áudios 
são transformados e guardados em 

CD. 
 
 
 

 

 

 

Fig 2. Janela do Edit View Fig 2. Janela do Edit View 

Fig 3. Janela do Multitrack View 

Fig. 4 Janela do CD View 
 

Manual – Edição Digital em Adobe Audition                                         Page 5 of 44 



 

Estas três áreas de trabalho que Adobe Auditiva oferece permitem que todo o processo de edição 
seja possível ser feito dentro do computador sem precisar de recorrer a meios e recursos mais 

morosos e caros. 

Em seg ios que fazem do Adobe Audition uma um forte processador 
de ficheiros áudio. 

 

B. Menu Bar

uida vamos conhecer os acessór

- Situ a parte superior da janela do Adobe Audition, menu bar contêm comandos 
para a realização de várias tarefas, como por exemplo abrir um ficheiro áudio. 

ado n

 
 

C. Toolbars- Situad

ra. Estas ferrame
organ

importantes que são u
mistu

(i) View Toggle
Edit View, 

Edit View 
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Fig 5. Menu Bar 

 

o um pouco

ntas tornam o 
izadas em gru

 em baixo do Menu Bar, toolbar contêm ferramentas muito 
sadas no decorrer de uma sessão, de uma masterização ou de uma simples 

trabalho muito mais prático. O toolbars tem as ferramentas 
pos os quais vamos conhecer em seguida: 

 

 

s — É o admin
Multitrack Vie

Multitrac

Fig.7 .V

 Adobe Audition
 Fig 6.Toolbars

 

istrador das áreas de trabalho e é composto os pelos botões 
w e CD View, perm caz de 

visualização

 
 
 
 
 

itindo a mudança rápida e efi
; 

 
 
 
 
 
 
 
 
 

k View 

CD View 

iew Toglets 
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(ii) Multitrack File — A partir desta ferramenta é possível abrir uma existente ou uma   
nova sessão, importar ficheiros e até salvar sessões e ficheiros. 

 

1 

2 

1. Abrir uma nova sessão 

4

5

 

 
(iii) Multitrack Edit 

 
 

e 

 
 

1. Undo

2. Abrir uma sessão existente 

5. Salvar sessão usando outro nome       

3. Importar ficheiros  

3 4. Salvar sessão 

Este conjunto de ferramentas quando bem usadas fazem milagres, por exemplo, passar de um
ficheiro para o outro fazendo combinar os níveis de volume, quer dizer, enquanto aquele qu

termina perde volume gradualmente, o que inicia ganha também gradualmente, fazendo 
ambos um jogo de combinação que tem como finalidade misturar de forma suave e 

imperceptível. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 ( )–  é o botão que nos permite voltar atrás se tivermos
serve enquanto as alterações não estiverem salva

2. Split clip
 

 ( ) - esta ferramenta divide ficheiros permitindo
independente das partes separadas; 

 

1
2
3
4
5
6
7
8
9
…

 

7 
5 1 

2 
3 

4 6 

9 

8 

Fig. 9 - Multitrack Edit 
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 - Undo 
 - Split Clip 
 - Cut Waves 
 - Mixdown selected files 
 – Crossfade  
 - Punch-in at selection 
 - Mute selected 
 - Time lock clips 
 - Group/ungouup clips 
  
Fig. 8 - Multitrack View
 errado. Este botão sò 
das; 

 um manejamento 
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3. Cut Waves ( ) - esta ferram nta exclui a parte seleccionada. 
4. Mi

e
xdown ( ) - esta ferramenta faz a fusão de ficheiros sem sair da sessão de misturas; 

 (5. Crossfade ) – esta ferramenta diminui ou aumenta progressivamente o volume do 
ficheiro nas partes seleccionadas; 

 
6. Punch-In ( ) - esta ferramenta permite e  tempo real, regravar no m  arquivo já 

existente substituindo o que e
 

7. Mute

m eio de um
xistia de antemão. 

 ( ) - esta ferramenta coloca em silêncio qualquer ficheiro áudio. Suponhamos que você 
queira silenciar um ficheiro que esteja numa pista che amenta você pode desactivar 

somente o ficheiro que pretendes silenciar sem exer nos outros. 
 

8. Time Lock

ia, com esta ferr
 no entanto m

 ( ) - esta ferr imento horizontal do ficheiro 
permitindo somente o movimento vertical, em outras palavras ele impede que o ficheiro 

9

amenta “tranca” o mov

movimente-se ficando fora do  tempo, descompassado. 
 

. Group/ungroup ( ) - com esta ferramenta é possível agrupar ficheiros, diminuindo o
 de existir um ficheiro fora do tempo. Para que isto não aconteça agrupa-se os fichei

lmente feito aut

 
risco ros 

logo o que for feito em um será igua omaticamente pelo computador em 
qualquer outro ficheiro que zer parte do mesmo grupo; 

(iv) Multitrack tools

fi
 

 

“Multitrack tools” é o conjunto das  ferramen ais usadas no Adobe Audition, com elas 
seleccionamos ficheiros, movemos e copiam . O conjunto é constituído por três botões a 

1. Hibrid T esma função do segundo e do terceiro botão, 
é uma ferramenta híbrida porque consegue fazer o tudo que zem. 
Estas duas funções são separadas uma para cada botão do m  

do mouse é usado para seleccionar arquivos, e se situar no tempo enquanto que o 
botão direito é usado para Mover e copiar arquivos. 

r 

 
o

 

1 - Hi

 
tas m
os

saber: 
 
 
 
 
 
 
 

ool - esta ferramenta tem a m

brid Tool 
2 - Ti l me selection too
3 - Move/Copy Clip tool 

1 2 3 

Fig. 10 – Multitrack Tools 

 os outros botões fa
ouse. O botão esquerdo

 
2. Time Selection Tool -  esta ferramenta ajuda a se situar  no tempo e a selecciona

ficheiro ou porções deles. 

3. M ve/Copy Clip tool - esta ferramenta move e copia ficheiros. 
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Nota: mo  especiais.  o Botão direito do use é usado em todos os casos para aceder a algumas opções
 
 
 
 

(v) Windows Toggles 
 

É o gerenciador de janelas. A partir desta ferramenta é possivel exibir ou esconder janelas. 
são aqui administradas, janelas como: misturadorTodas as janelas  e equalizador. 

 

 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig 12 - Organizer windows 

A Janela Organizadora, é um exemplo de 
a janela das doze que existem dentro da um

janela prin
importante
em uso, a lista dos efeitos e as acções 
favoritas. 
 

indow  

cipal do Audition. É das mais 
s porque nela ficam os arquivos 

1 - Organizer W
2 - Session Properites 
3 - Mixer 
4 - Track equalizer 
5 - Track Properties 
6 - Cue List 
7 - Transport Control 
8 - Zom Controls 
9 - Time Window 
10 - View Control 
11 - Level Meters 
12 - Vídeo Window 
13 - Satus Bar 

1 2 3 4 5 6 7 8 9 1210 13 11

Fig. 11 – Windows Togglets 
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(vi). Transp t Controlsor  

Este conjunto de ferramentas é essencialmente conhecido por todos, excepto dois novos 
componentes que podem ser novidade para alguns, 

1. Play from Curso

 

 

 

 
 
 
 
 
 
 
 
 

r ( ) – Este botão roda o fi eiro a parti
ao fim do ficheiro; ou seja, a diferença com o botão Play 

ch

seleccionarmos parte do ficheiro, este últim  só toca a p
primeiro toca até ao fim da fa

2. Play Looped (

o

) – Este botão roda infinitamente a p
seleccionada. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

1 

2 

Fig t C trolonanspor Tr. 13 –
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1 – Play from Cursor  
2 – Play Looped 
r de onde o curs
normal (

or se encontra até 
) é

arte selecciona
ixa. 

 que, no caso de 
da, enquanto o 

arte visível na tela ou a parte 
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Diferenças entre Multitrack e Edit View 
 

Edit view e o Multitrack View se diferem nos métodos usados para editar os ficheiros áudio; 
 

 Edit View  usa métodos destrutivos, pois ele anentemente os ficheiros quando 
salvadas as alterações; 

 Multitrack View usa métodos de edição não destrutivos as alterações não são 
permanentemente salvadas, sendo p sível fazer  futuro. 

 
endo o Zoom

 altera perm

os  modificações no

1. Faz  
 

O zoom ajusta a resolução gráfica do painel, permitindo uma visualização mais precisa ou mais 
amp

Vários são os métodos que o Adobe Audition usa para manejar a resolução gráfica (imagem): 
 

1.1 Fazendo zoom a partir do painel “Painel Zoom”

la dinamizando todo o processo de edição. 
 
 
 
 
 
 

Fig. 14 - Zoo

 

 Clique no botão  para ampliar a resolução vertical; 
 Clique no botão  para ampliar a resolução horizontal; 

 Clique no botão  para diminuir a resolução vertical; 
 Clique no botão  para diminuir a resolução horizontal; 

 Clique no botão  para ampliar qualquer parte seleccionada; 

 Clique no botão  para ampliar a fronteira esquerda de parte seleccionada ; 

 Clique no botão  para ampliar a fronteira direita da parte seleccionada; 

1.2 Faze

 
 

ndo o zoom a partir do “scrool bar” 
 

Mova o ponteiro do mouse até uma das extremidades da barra na parte superior do painel, clique e 
arraste a extremidade da barra para am liar ou reduzir a resolução horizontal; p

 
 
 
 

m 

Fig. 15 – Scrool bar 
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Fig. 16 – Scrool bar 

Mova o ponteiro do mouse até uma das 
extremidades da barra lateral esquerda do 

painel, clique e arraste a extremidade da barra 
u reduzir a resolução 

vertical;(esta opção é executável somente no 
to 

fácil da vista das pistas ). 

 

 
 

 

para ampliar o

Multitrack View para permitir o manejamen

 

 
 

 
2. Navegando no Adobe 

 
Para navegar bem no adobe Audition é importante conhecer certas coordenadas como o número da 
pista, tempo e nível do som, estas coordenadas se encontram descritas em réguas situadas no lado 

direito e inferior do painel principal. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Réguas 

Fig. 17 – Réguas de Navegação
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Importância d

 

a régua 

m a controlar e medir os níveis e posições dos 
aço, o tempo e os níveis amplitudes. 

 
As réguas são bastante importantes porque nos ajuda

arquivos; através delas controlamos o esp
 

Existem três tipos de réguas a saber: 
 

 Régua de espaço – serve para controlar a faixa em que se encontram a dada 

 Régua do Tempo

 os ficheiros num
mistura. 
 
 
 
 
 
 
 
 
 
 

Fig.18 – Régua de Espaço

 
 

 – Serve para o controle do tempo (em hms) 

 Régua do volume

 
 
 
 
 
 

Fig. 19 – Régua do Tempo 

 
 – Serve para monitorar o nível do som para que não se exceda 

 
 
 
 

 
 
 
 
 
 
 Fig . 20 – Régua do Volume 



Editando no Edit View; 

1.Abrindo ou criando arquivo 

udio 
No display do “Edit View”, você pode editar com precisão o ficheiro audio, graças as diversas 

 
 

Para abrir um ficheiro audio: 
 

 a) No menu bar clique em File > Import 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.Editand  o áo

 

b) seleccione o ficheiro  
   que pretende abrir  
    e clique em “Open” 

Fig. 22 – Open file

Fig. 21 - Import file 

ferramentas de trabalho que o Adobe Audition oferece. 
 

 

 

 

 

 

 Fig. 23 – Editando  
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3.Aplicando efeitos 
perfeições, dar profundidade, etc. 

Você pode aplicar os efeitos como e onde desejar, mas é preciso ter cuidado para que os efeitos não 
alterem heiro. 

4.Gravando alterações 
Depois de editar os ficheiros áudio chegou a hora de gravar o trabalho de horas em lugar seguro para 

que não se perca. Podemos gravar no nosso próprio computador (em discos duros) ou em CD’s 
áudio passando os ficheiros para  “ CD Project View” que em seguida concluirá  o trabalho por si 

só. 

4.1.Salvando as alterações no computador 

 

 

 

 

 

ave As 

b) Defina o nome do  
   ficheiro e clique em 
   ‘Save’ 

Aplicar efeitos é dar ênfase aos ficheiros, enfeitá-los, cobrir im

 negativamente a qualidade do fic
 
 
 
 
 
 
 
 
 
 
 
 
 

Lista de 
Efeitos 

Fig. 24 – Lista de efeitos

 

 
a) Clique em File>S

 

 

 
Fig. 25 – salvando Alterações 



Editando no Multitrack View; 

II. Passo-a-passo de uma Multi-Edição 
 

1. Abrindo sessão; 

2. Inserindo ficheiros; 

3. Arranjando ficheiros; 

4. Aplicando efeitos; 

5. Misturando pistas; 

6. Exportando. 

1. Abrindo ou criando sessão

 
 

 

A partir da opção File no menu bar, escolha a opção ”New Session” e escolha do Sample Rate. 
 

 

 
 
 
 
 Fig. 26 – criando sessão 
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2. Inserindo ficheiros 
 

Para inserir ficheiro áudi ovo áudio, você precisa 
transportar os ficheiros do Painel de Arquivos (O s pistas, ou então fazer 

uma nova gravação directamente nas pistas dução de ficheiros não se difere do 
processo a te. 

3. Arranjando ficheiros

o, vídeo e MIDI nas pistas, ou gravar um n
rganiser) e colocá-los na

. O processo de intro
presentado anteriormen

 

 
 

Se por algum motivo os ficheiros encontram  preciso acertar movimentando-os 
até que estejam todos em total harmonia, e se al uito devagar ou muito rápido é 
possível alterar o seu tempo arrastando o “tim itos outros arranjos são possíveis no 

Adobe Audition, de acordo com as metas que se pretende alcançar. 

-se descompassados é
gum ficheiro toca m

eline”, este e mu

 
 

 
4. Misturando as pistas 

enos que equilibrar ficheiros que são tocados em simultâneo. No Misturar pistas é nada mais nada m

“Toolbars” é visível o botão ( ) “The Mixer” que apresenta os variados níveis cada pista, esta 
opção dá a possibilidade de equilibrar arquivos de modo a fazer com os mesmos estejam tocando em 

harmonia proporcionando resultados satisfatórios. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
       Fig.27 - ara uilibrar sons  Misturador muito usado p eq
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5. Exportando 

P  

 64-bit doubles (RAW) (.dbl) 
 8-bit signed (.sam) 

wav) 
 ACM Waveform (.wav) 

 Windows Media Audio (.wma) 
 Windows PCM (.wav) 

O formato que será usad ante. Guardar o ficheiro 
no formato Windows PCM (.wav) é muito diferente de gravar no formato MP3 (.mp3), porque para 
além do ficheiro wav ser maior em termos de tama ho, ele conserva as características do ficheiro até 
ao mínimo detalhe, o que se pode dizer  “perfeitas condições” do ponto de vista de edição, enquanto 

que o formato mp3 não conserva mínimo detalhes e tem tamanho muito reduzido. 
Para gravar uma mixagem de ficheiros em um exportar a mixagem em 

formato wav ou mp3. No Menu bar, clique em File>export>áudio, em seguida verificar o formato, 
dar nome e exportar. 

Exportar áudio não é tudo; é recomendado que se volte a introduzir o áudio no programa para 
finalizar a edição. 

 
ara exportar ou gravar um ficheiro é necessário que se escolha o formato que se pretende usar para

armazenar o ficheiro, a seguir é apresentada a lista de alguns tipos de formatos: 
 

 A/mu-Law Wave (.

 Amigas IFF-8SVX (.iff, .svx) 
 Apple AIFF (.aif, .snd) 
 ASCII Text Data (.txt) 

 mp3PRO® (.mp3) 

 
formatos recomendados sãOs o: 

mp3PRO® (.mp3) 
Windows PCM (.wav) 

 
o para armazenar o arquivo é extremamente import

n

s 
único arquivo é preciso 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(i.) Para exportar áudio, 
Clique em File > Export > 
Audio 

Fig. 28 – Export Audio 
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 (ii.) O segundo passo da 

e  
 

xportação é escolher o 
ar nome e exportar 

 
 
 
 
 
 
 
 
 

formato, d

Fig. 29 – Export
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III. IMPORTANDO, GRAVAN O ÁUDIO 

Importando com o painel de a
Para Importar arquivos áudio, que estejam guardados em seu computador basta que, no painel de 

DO E TOCANDO 
 

rquivo; 

arquivo (organiser) apertemos o botão import , em seguida selecçionamos o arquivo que 
pretendemos abrir e clicamos no botão Open. 

 
 
 

Botão Import 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.30 -Painel de Arquivos (Organizer) 
Edição Digital em Adobe Audition  



 
 
 
 

 

 

 

 

Importando Áudio de CD
Os Arquivos áudio ao serem grava
quando pretendemos importar arq
da gravação, ou por outras palav

formato, par
Para importar ficheiros áudio de C
edição “CD Project View” basta s

o

Manual – Edição Digital em Adobe Au
 Fig.31 - Janela Im ortp

 
 

s; 
dos para CDs á dio, sofrem uma conversão de
uivos áudio de CDs devemos passar por um p

ras pode-se dizer que o ficheiro áudio sofre um
a um formato digital possível de ser editado. 

Ds áudio em A obe Audition é extremamente
eleccionar em “File” na Barra de Menu, em se
pção “Extract a áudio from CD”. 

u

d

 
 

dition                                         Pag
Botão para abrir
ficheiro 
 formato, portanto, 
rocesso inverso ao 
a re-conversão de 

 fácil. Na visão de 
guida seleccionar a 

e 20 of 44 



 
 
 
 
 

Em seguida uma janel
escolher e ainda
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Fig.32 - Importando áudio de CDs 

 

a se abrirá, é a janela de propriedades de extracção, onde podemos ouvir, 
 a velocidade que pretendemos usar para extrair os ficheiros do CD. 
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Finalmente seleccionamos o botão OK para iniciar a importação. 

NOTA: Depois de se extrair arquivos de CDs é expressamen omendável salvar os mesmos em seu computador, pois 
estes arquivos antes de serem gravados no c putadors só existem no painel de arquivo; 

 

Gravando e tocando áudio: 
Até então ainda não abordamos uma das mais importantes funções que o Adobe Audition oferece: 
“GRAVAR”. Esta função vem ampliar o mundo de Edição Digital e ao mesmo tempo dar asas á 
imaginação e criatividade de quem usa este programa para fins radiofônicos, comerciais ou para 

outros fins como puro entretenimento, criando e desenvolvendo sons originais e de altíssima 
qualidade. 

 
Em seguida vamos aprender como criar um ficheiro. 

 

Para criar um ficheiro novo, directamente nas pistas só é possível se tivermos connosco um conjunto 
de acessórios externos que servem para introduzir os sons no computador, neste caso concreto seria 

por exemplo um microfone ou então um piano ou guitarra. Em seguida se os cabos estiverem 
ligados correctamente, e se as config  certas prosseguimos com os 

os: 

Fig. 33- Extaíndo “aduio de CDs 
 
te rec

om
 
 

urações do computador estiverem
seguintes pass
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A

B

 

 

 

A. Active o Botão (
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)“Arm Track for Recording” no início de cada pista, para armar a pista, ou 
seja, fazer com que ela esteja apta a receber informações. 

B. Em seguida Active o botão ( ) “Recording” para iniciar a gravação. 

Se a captação estiver a decorrer perfeitamente, será visível o nível do sinal captado através das 
amplitudes deste acompanhando o movimento do cursor. Caso isto não aconteça, a gravação não 
está a ser feita; deve-se interromper o processo e verificar as ligações do microfone e dos outros 

periféricos. 

Quando a captação termina, activa-se o botão Stop ( ) ou novamente o botão Record ( ) para 
parar o processo e em seguida desativa-se o botão ( )“Arm Track for Recording” da pista em uso. 

 
 
 

Tocando 

Fig 34 – Gravando áudio 



Finalmente para tocar ou para fazer um play back do ficheiro criado ou de qualquer um ficheiro, que 
esteja nas pistas do Multitrack View ou no Edit View, basta apenas activarmos o botão “play” , 

na janela dos controles de transporte como falamos anteriormente(Componentes básicos). 

 

 

 
 

 ARQUIVOS ÁUDIO 
Fig.35 - Tocando arquivo 

IV. EDITANDO

 

C

seguirmos os passos que te serão demonstrados: 
 

1. Na janela do Edit View, você pode visualizar o gráfico do arquivo que pretende copiar,  
selecçione a parte do arquivo que pretende copiar. 

2. No “Menu Bar” escolha uma das alternativas seguintes: 
• Edit > Copy, para copiar a parte seleccionada; 

• Edit > Copy to New, para copiar e passar directamente para um arquivo novo; 

 

opiando, cortando e apagando arquivos áudio 
Para copiar, cortar ou apagar arquivos áudio em Adobe Áudition é extremamente simples basta 

 seguidamen

 
Como copiar ou cortar arquivo 
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• Edit > Cut, para cortar a parte selecçionada do arquivo, que de seguida a mesma, pode 
ser passada para outro ficheiro; 

 
 
 

Como passar um arquivo copiado para um arquivo novo 
1. Na janela do Edit View, visualize o arquivo para o qual pretende inserir o arquivo copiado e 

situe o cursor exactamente no lugar onde pretende passar arquivo ou selecçione o arquivo 
que pretende substituir; 

2. Em seguida no “Menu Bar” escolha uma das alternativas seguintes: 
• Edit > Paste; 

• Edit > Paste to New, para passar para um arquivo novo; 
 

Como apagar arqivos 
Para apagar arquivos selecçione a parte que pretende apagar e no “Menu Bar”, escolha Edit > Delet 

Selection. 
 
 
 
 
 
 
 
 
 
 
 

V. APLICANDO EFEITOS 
Na edição digital de arquivos áudios, existem várias maneiras de aumentar a qualidade dos arquivos, 

o só aumentar a qualidade dos 

Aplicando efeitos no Edit View; 
Pa

“Org  
clicando duas vezes co á uma janela para 

 
 
 
 

aplicar um efeito é uma delas. Colocando um efeito, podemos nã
arquivos áudio, podemos também aumentar o desempenho dos mesmos fazendo os soar de maneira 

diferente. Os efeitos são recomendados na edição de arquivos áudio. 
 

ra aplicar um efeito no Edit View, sobre um arquivo áudio, basta selecçionarmos na janela 
anizer Window” (veja-componentes básicos), na lista dos efeitos, o efeito que quisermos usar

nsecutivas sobre o nome do efeito. Logo em seguida se abrir
edição as propriedades dos efeitos. 

Em seguida serão demonstrados os passos a serem seguidos na prática. 
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Passo-a-passo 

1. Abrir Janela de Efeitos; 
2. Selecç nar o efeito; 

3. Configurar as propriedades do efeito; 
io

4. Aceitar configurações 
 

 

 
 
 

licando efeitos no Multitrack view; 
i.  

la, é possível aplicar efeitos sem precisar alterar os ficheiros perma

Ap

Na visão múltip
torna possível que no futuro, caso queiramos retirar ou mudar o efeito, consigam

 FX, no início de qualquer pis

pa
c

pista. Em

aplicar efeitos temporários seleccionamos o botão
selecçionamos o efeito que pretendemos aplicar. Ao activar o efeito em uma pis
tente em toda pista do início ao fim, de modo que se retirarmos o ficheiro da pi

olocarmos em uma outra, o ficheiro perde os efeitos que tinha quando estava na p
sujeito aos efeitos da nova pista em que foi colocada, caso estejam activados algu

os ver passo-a-passo como activar os seguida vam  efeitos em um

1. Abrir janela de efeitos 

3. Configurar 
2. Selecçionar Efeitos Propriedades 

Fig. 36- Aplicando Efeitos 
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4. Aceitar
 

nentemente, isso 
os o fazer. Para 
ta, em seguida 

 
 

ta o efeito fica 
sta com efeito e
ista anterior e fica
ns efeitos nesta 
a pista. 
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a) Activar o botão Track Effe

Settings 
cts 

( ) no início
 
 
 

 
 
 
 
 

 
b) Depois de activado o botão dos efeitos, se abrirá uma janela que vai apresentar-te de um lado a 
lista dos efeitos que podes activar na pista e do outro a lista de efeitos que já estão activos na pista. 
Para activar um efeito basta somente fazer um duplo click no efeito que pretende activar e clicar em 

OK. 

 da pista; 

 
 

 
 Fig. 37 – Track FX 

 
 

 

Para usar efeito: Escolher o efeito da lista à esquerda (Installed Real-Time Effects), clicar 
no botão Add (

Fig. 38 – Ef ts fec ack R

); o efeito aparece listado na janela a diteita (Current Effects 
Rack). Repete-se o processo para incluir mais efeitos. Caso queira retirar alguns efeitos,

selecçione o efeito da lista e clique no botão Remove (

 

). 
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c) Se o efeito já estiver activo mas o resultado não for o esperado, talvez porque esteja em excesso 
ou porque não se faz sentir no nível esperado, é 

possível alterar a config
alterar a configuração pr asta um 

simples clique sobre o mes o botão FX. Desta 
vez o Adobe Audition irá apresentar uma janela 
diferente, nessa janela é possível fazer alterações 

no efeito até que ele atinja os resultados 
desejados. 

O aspecto desta janela varia de acordo c efeito que esta activo para este caso concreto o 
efeito usado foi o de “Studio Reverb”. A partir dos botões exibidos nesta janela é possível 

alterar acção dos efeitos. Depois de serem feitas as devidas alterações a janela pode ser 
fechada normalmente que os efeitos estarão alterados segundo as modificações feitas. 

 
Suponhamos que você pretende mudar, acrescentar ou simplesmente retirar os efeitos colocados, aí 

surge a questão “como fazer?”. 
 

Retirar, acrescentar ou substituir efeitos é mais simples do que se pode imaginar, basta um clique no 
botão direito do mouse, sobre o botão de efeitos (botão 

uração padrão. Para 

 

edefinida, b
m

 
 
 
 
 
 
 
 
 

 
om o 

Fig. 39 – Janela dos Efeitos 

) em seguida selecçionamos o 
“Rack Setup”, é apresentada agora a mesma janela apresentada no inicio do processo de colocação 

de efeitos, nela é possível retirar efeitos existentes ou acrescentar novos. 
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Colocar efeitos em
ficheir

ficheir
Então caso o 

Audition pode exibir uma inform r é incapaz de rodar a mistura. 

 as capac o 

 
 
 
 
 
 
 
 
 
 
 
 
 

Seleccione o efeito 
que pretende remover 
e clique em Remove 

 pistas não é tarefa fácil para o com utador pois ele, a medida que vai tocando um 
o os efeitos activados nas pistas são processados no mesmo instante (em tempo real) sobre os 

os afectados. isto exige do computador grandes capacidades de processamento e memória. 
 o computador que estiver usando não tenha grandes capacidades é recomendado que nã

abuse dos efeitos. 

p
Fig 40 – Removendo efeitos 

 
Se a quantidade de efeitos estiver acima das capacidades suportadas pelo seu computador o Adobe 

ação avisando que o computado
 

NB: A quantidade de efeitos possíveis de serem colocados é directamente as capacidades do 
computador, isto é quanto maior forem idades de processamento e memória d
computador maior é a quantidade de efeitos posáveis de serem rolados em tempo real. 
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VI. MISTURAS 
 

As misturas no Adobe Audition são feitas na visão múltipla ou Multitra
Agora vamos conhecer o passo-a-passo de montagem de uma ses

 
 

ck View. 
são. 

 

Lista 
Pistas 

 
 Fig. 41 - Janela de mistura 

 
 
 
 

Os Passos da montagem de uma sessão são os seguintes: 
 Seleccionar ficheiros a serem usados; 

 Definir sequência; 
 Montar ficheiros; 

 Variação e aplicação de efeitos; 
 Misturas; 

Vamos então montar uma sessão. 
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1o Passo: Seleccionar ficheiros a serem usados; 
a serem usados. Estes juntos formam uma lista, a mesma que serà usada para Importa-se os ficheiros 

montar a sessão. 
 

 
 

2o Passo: Definir sequência e montar ficheiros 
Depois de elaborada a lista é necessário organizar os ficheiros em sequência, esta organização é feita 

nas pistas da visão múltipla, arrastando o ficheiro da lista para as pistas 

Importando ficheiros 

 
 
 
 
 

Ficheiros a serem carregados e colocados nas pistas 

Fig.42 – Importndo Ficheiros 

Fig. 43 - Pistas 
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Em seguida para que não haja uma mudança agressiva de sons, combinamos os volumes dos pontos 
de encontro de encontro entre dois ficheiros, enquanto um desaparece gradualmente, outro aparece. 
Para fazer isso seleccionamos somente o inicio caso o ficheiro esteja para entrar ou então o fim para 

o ficheiro que termina, depois que seleccionamos, na barra “Multitrack Edit” ligamos o botão 
Sinusoidal Crossfade, para diminuir ou aumentar au e ao longo da parte 

seleccionada. 

 
 

Ficheiros colocados; sequência criada 

 

tomaticamente o volum

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sinusoidal Crossfade 

Fig.44- Sequência 

Fig 45 - Crossade 
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3o Passo:Variação e aplicação de efeitos 

Gráfico do PAN é um gráfico que regula a distribuição do som emitido nas saídas direita e equerda. 
Por exemplo arrasta um certo som para tocar som  lado das saídas, então se o som estiver 
a sair por exemplo pelas colunas normais de um omputador, somente  uma coluna liberta o som. 

Depois de se ter colocado as variações montamos os efeitos e usamos misturador para normalizar o 
volume de cada pista. 

Ao longo do percurso de uma mistura pode ser necessário diminuir por instantes o som de algum 
fichero ou alterar o PAN. Entretanto para fazer isto contamos com ajuda de algumas linhas que 

aparecem visiveis das por cima dos gráficos dos ficheiros. Aprenderemos em seguida como variar o 
pan e o volume do ficheiro sem precisar mexer no volume principal da pista. 

 
 

 
 
 
 
 
 
 
 
 
 

Combinação 
Fig.46 - Combinação 

Gráfico do PAN 

Gráfico do volume 

Fig. 47 – Linhas de Ajuda 

ente de um
 c
 

 
 
 
 
 
 

 
Manual – Edição Digital em Adobe Audition                                         Page 33 of 44 



VII. MASTERIZAÇÃO 

A propalada palavra “masterização” existe desde que se começou a gravar discos há cerca de 
um século. O termo se popularizou com a introdução do CD e dos recursos digitais de edição do 

áudio. Masterizar quer dizer “passar para a master”, a fita matriz que contém o material 
finalizado. Então, se “mixarmos” um trabalho e g os o resultado numa fita cassete, estamos a 

masterizar em cassete; hoje em dia, com os avanços tecnológicos já podemos masterizar directo para 
o CD. 

Nos tempos analógicos, já se editava material “mixado” numa fita, transferindo o resultado 
para uma só fita. Só que usar um mouse é muito m is fácil. Daí, desde que se começou a gravar em 

computador, as técnicas de pré-masterização (ed ção do material stéreo) se difundiram em larga 
escala, alcançando boa parte dos estúdios caseiros. 

Na masterização o que está em questão, além das técnicas de acondicionamento das gravações num 
suporte físico, no caso o CD, são os procedime os a qualidade do material, 
redução de ruídos, equilíbr  Adobe Audition oferece 

 

ravarm

 

a
i

 

ntos para recuperarm
io dos timbres, ganho de volume e outros. O

todos estes recursos e faz do seu PC um pequeno estúdio. 
 
 

PASSO-A-PASSO DE UMA BOA MASTERIZAÇÃO 
 

O primeiro passo è verificar o nível do ruído, e se preciso, reduzi-lo, mas há que ter muito 
cuidado ao diminuir o nível do ruído para não udar os timbres de vozes e instrum

desequilibrar a mixagem. 

Em seguida, ouvimos com muita atenção para verificarmos se os timbres estão bem 
equilibrados, se for absolutamente necessário corr i-los usamos um equalizador de 10 Bandas, mas 

cuidado o equalizador não inventa frequências que não existem apenas reforça ou atenua o que já 
esta gravado, então quanto mais alteramos o equilíbrio das frequências graves, médias e agudas, 

mais riscos corremos de deformar o nosso trabalho por isso o ouvido deve ser muito bem usado para 
 bom

os desagradáveis segundos de espera no fim de cada mistura. 

O passo seguinte é o da introdução de efeitos, de acordo com as finalidades e gostos os 
efeitos podem ser aplicados para dar mais ênfase a mistura. 

Em seguida caso você esteja misturando ficheiros em pistas è hora equalizar os níveis de 
todos os ficheiros até que a mistura esteja boa, é muito importante que os níveis do ficheiros não 

 m entos ou 

 

ig

garantir um  resultado final. 
 

O Passo seguinte é o da compressão, a compressão traz o som mais para frente, isto é, 
comprimimos os picos de volume para podermos aumentar o volume médio. Mais uma vez cuidado, 

a ânsia de aumentar os volumes não deve permitir que tornemos a música “chapada”, sem 
profundidade. A compressão varia a medida que variam os estilos de musicas. 

 
A seguir cortamos o início e o fim do ficheiro. O corte é fundamental para que não existam 
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alcancem nunca o Zero Decibel 
ruídos o 

(0 dB), porque se alcançaram ou ultrapassam esta marca, contém 
que faz da mistura uma mistura saturada. 

A fase final do processo de masterização é passagem do produto final para o disco compacto (CD). 
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O PASSO-A-PASSO DE UMA MASTERIZAÇÃO NO ADOBE AUDITION 1.5 
 
 

Para masterizar no Adobe Audition 1.5 seguimos os seguintes passos: 
 
 

1o Passo: Eliminar ruído 

 

 
 
 
 

 
M

(i.) Na lista de efeitos do Edit View
faça duplo clique em Noise 
Reduction > Noise Reduction 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig. 48 – Eliminando Ruido

an
(ii.) Em seguida clique no botão
capture Profile 
 
 
 
 
 
 
 
 

 

Fig.49 – Noise Reducion 
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2o Passo: N  
 

 

 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 

 
 

ivelar as amplitudes

(ii.) Depoi
configure manualmente o nível do 
ruído que se pretende eliminar, em 
seguida seleccione OK e os 
serão removidos. 

el não 
tion 

Level = 1). 

(i.) aneira 
fáci ciona-se a parte que se 
pretende nivelar, em seguida na lista de 
efeitos seleccionamos Amplitude > Hard 
Limiting . 

s de capturado o ruído 

ruídos 

Dica: recomenda-se que o nív
passe o número 1 (Voice Reduc

 
 

Fig. 50 – Nível de redução de ruído 

Fi  51 – Nivelando Amplitudes 

Para nivelar amplitudes de uma m
 e rápida, selecl

g.
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(ii.) Agora selecçione a amplitude máxima que o gráfico 
e atingir. A amplitude deve ser menor qu
e estar muito acima nem muito abaixo d
ial porque se assim for, o ficheiro 
ndes alterações na qualidade. 

 
 

dev e 0dB e não 
pod a amplitude 
inic pode sofrer 
gra

A régua do nível de amplitudes, es
gráfico, nela se ver e monitorar to

Fig 52 – Hard Limit 

Fig. 53 – Usando régua para nivelar amplitude 

tá do lado direito do 
das amplitudes.  
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Depois de se ter nivelado as amplitudes, pode ser que tenhamos perdido volum heiro, nesse 
e, este normaliza some te o volume do 
alidade do mesmo. 

 
Nota: A normalização pode ser feita em percentagem 

de espaço ocupado ou em decìbeis (dB). 
 
 
 
 
 
 
 
 

 
 

(iii.) Escolha o nível de normalização que pretende usar, e m seguida clique em OK. 
 

Se prestares muita atenção às figuras, descobrirás que existe uma diferença nas duas imagens; uma 
Decibels Format não está activada, enquanto que na outra está; isto marca a diferença entre as duas 
maneiras de normalizar, mas tecnicamente não existe nenhuma diferença em norma zar um ficheiro 

em percentagem ou em decibel. 
 
 

Para recuperar o volume, na lista de 
efeitos seleccionamos em Amplitude > 
Normalize 

e do fic
caso usamos um outro recurso para recuperar o volum

ficheiro sem o alterar em nada a qu
 
 

 

n

 
 
 
 
 
 
 
   Normalização em percentagens   Normalização em decibéis 

Fig.34 – normalizando arquivo 

Fig 55 – Formas de normalizar arquivos

li
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3o Passo: Cortar espaços desnecessários 

M o 
fim, então estes interv

seleccionamos o intervalo e clicamos no botão “Cut” no menu bar, para excluir o intervalo. 

O procedimento é o mesmo tanto para o início como para o fim 

Caso exista um intervalo no meio da gravação, e seja preciso tirar o procedimento a usar não 
pode ser este, porque o intervalo não deve desapa r é o que está gravado 

nele, assim sendo devemos então silenciar o intervalo. 
 

Para silenciar o intervalo, em primeiro lugar seleccionamos o intervalo, em seguida na lista 
d  Silenc  e o silên ida. 

 
 
 
 
 
 
 

 
uita das vezes em que gravamos alguma coisa, deixamos sempre um intervalo ou no início ou n

alos devem ser cortados ou silenciados. Para cortar um espaço desnecessário 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

recer o que deve desaparece

e efeitos clicamos em “Apply e” cio é removido em segu
 
 
 
 
 
 
 

 
 

 

Botão “Cut” para cortar a 
parte seleccionada 

Fig. 56- iliminando silencio 

Fig. 57- Aplicando silencio 

Intervalo antes de se silenciar 
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Intervalo silenciado 

4o Passo: Introduzir efeitos 

Os efeitos são aplicados para dar aos ficheiros uma qualidade diferente, os mais comuns 

Para introduzir um efeito terá que seleccionar o ficheiro ou parte dele, escolher na lista de 
ef

 
 
 

 
 
 

 

usados por muitos produtores, são os efeitos de eco. 
 

eitos qual ou quais os efeitos que serão usados, e em seguida aplicar os efeitos. A seguir 
demonstraremos como fazer isto. 

(i.) Se
parte dele e escolhemos o 
efeito, por exemplo na lista de 
efeitos em Delay Effects 
escolhemos Studio Reverb. 
 

leccionar o ficheiro ou 

 
 
 
 

Fig. 58 -Silenciando 

Fig. 59 – Introdução do efeito 
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5o Passo: Gravar em Disco Duro ou em CD Áudio 

Gravar o produto final , nesta fase há que ter 
muita atenção no nível de volume do produto final, principalmente quando se trata rabalhos 
com

 
 
 
 
 
 
 
 
 
 
 
 

(ii.) Em seguida, se abrirá uma 
janela, nela podemos escolher entre 
opções exibidas qual é que 
preferim s usar, em seguida 
clicamos em OK para aplicar o 
efeito. 

o

 
 
 
 

Fig. 60 – Escolha de Efeitos 

 

 
 é o último passo da masterização no Adobe Audition

postos por vários arquivos, é necessário se fazer uma boa mistura no final do trabalho. 
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VIII. GRAVANDO CDs 
 

Gr o um programa qualquer, não tem grandes diferenças com a 
ár dition, a única diferença é que aqui você pode masterizar os 

ficheiros áudio que farão parte do CD. Uma vez feita a lista você deve verificar se todos so ficheiros 
toc vitar que não hajam diferenças de volumes ao longo da gravação 

final. 
 

Por fim, exporte a sua mistura final para um arquivo em seu computador ou grave directamente em 
CD’s de áudio. 

 
 

avar um disco em computador usand
ea de edição de discos do Adobe Au

am num nível semelhante para e

 

Para gravar um CD áudio 
no Adobe Audition, em 
primeiro lugar crie uma 
lista dos ficheiros a 
gravar, e em seguida 
clique
para c
 

Para gravar um CD áudio 
no Adobe Audition, em 
primeiro lugar crie uma 
lista dos ficheiros a 
gravar, e em seguida 
clique
para c
 

Introduza um disco virgem no seu 
gravador de discos, e em seguida 
clique em “ Write CD” 
Agora é só esperar que o computador 
termine de gravar. 

 em “Write CD” 
omeçar o Processo. 
 em “Write CD” 
omeçar o Processo. 

 
 
 
 
 

Fig. 61 – Gravação de CD Áudio 
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IX. FUNDAMENTOS DO SOM DIGITAL 
 
 
 
 

E

Fundamentos do som 
Som é criado no ar por vibrações, produzidas por exemplo por um fio de violão, pela voz ou por 
altifalantes. Estas vibrações forçam colectivamente as moléculas de ar, elevando ligeiramente a 
pressão do ar. As moléculas de ar pressionadas, empurram então nas moléculas que as cercam, e 

 no próximo conjunto de moléculas, e assim por diante, causando uma 
capaz de se mover pelo ar. Como áreas de pressão altas movem pelo ar, elas 

s de pressão atrás delas. A propagação destas ondas faz vibrar os receptores de 
os nossos ouvidos, e nós interpretamos as vibrações como sons. 

 
 
 

Medidas de Ondas Sonoras 
 

Amplitude - Reflete a mudança na pressão do cume da onda sonora para a vala. As ondas de maior 
amplitude tem som alto e de menor amplitude são quietas. 

 
Ciclo - Descreve uma única e repetida sucessão de mudanças de pressão. Da pressão zero, para 

pressão alta, em seguida para a pressão baixa e novamente para pressão zero. 
 

Freqüência - Medido em hertz (Hz), descreve  o número de ciclos por segundo. (por exemplo, uma 
onda sonora de 1000 Hz tem 1000 ciclos por segundos). Quanto maior for a freqüência, maior será o 

tom musical do som produzido. 
 

Fase - Medido em 360 graus, descreve o a posição de uma onda no ciclo. Zero graus é o ponto de 
partida, seguido por 90graus que é a pressão alta, 180 é o ponto 

baixa e 360 é o ponto final. 
 

Comprimento de Onda - Medido em unidades como polegadas ou centímetros, é a distância entre 
dois pontos com o mesmo grau da fase. Com o aumento de freqüência o coprimento de ondas 

diminui. 

ntendendo o áudio digital; 
 

estas de seguida empurram
onda de pressão alta 
deixam baixas área

som n

de meio modo, 270 é a pressão 

 
 
 

 
Manual – Edição Digital em Adobe Audition                                         Page 44 of 44 


	I. INTRODUÇÃO
	II.ÁREA DE TRABALHO
	Componentes básicos
	Editando no Edit View;
	Editando no Multitrack View;

	III. IMPORTANDO, GRAVANDO E TOCANDO O ÁUDIO
	Importando com o painel de arquivo;
	Importando Áudio de CDs;
	Gravando e tocando áudio:

	IV. EDITANDO ARQUIVOS ÁUDIO
	Copiando, cortando e apagando arquivos áudio

	V. APLICANDO EFEITOS
	Aplicando efeitos no Edit View;
	Aplicando efeitos no Multitrack view;

	VI. MISTURAS
	VII. MASTERIZAÇÃO
	VIII. GRAVANDO CDs
	IX. FUNDAMENTOS DO SOM DIGITAL
	Entendendo o áudio digital;


